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Version history

Version Date Description
1.0 02/2023 First release of the document.
1.1 05/2023 Update to the acknowledgement statement on the copyright page.

Purpose of this document

This document provides information about and insight into the Code-Point Open product and its potential
applications. For information on the contents and structure of Code-Point Open, please refer to the
Overview and Technical Specification.

The terms and conditions on which Code-Point Open is made available to you and your organisation are
contained within Open Government Licence (https://www.nationalarchives.gov.uk/doc/open-government-
licence/version/3/) which allows you to use Code-Point Open in any way and for any purpose. We simply
ask that you acknowledge us with: "Contains OS data © Crown Copyright [and database right] 2023.
Contains National Statistics data © Crown copyright and database right 2023. Contains Royal Mail data
© Royal Mail copyright and database right 2023."

We may change the information in this document at any time, giving you the notice period set out in your
contract. We do not accept responsibility for the content of any third-party websites referenced or
accessed in or through this document.

This document has been screened according to Ordnance Survey's Equality Scheme. If you have difficulty
reading this information in its current format and would like to find out how to access it in a different
format (braille, large print, computer disk or in another language), please contact us on:

+44 (0)3456 05 05 05.

Copyright in this document

© Ordnance Survey Limited 2023. This document (including for the avoidance of doubt, any mapping
images reproduced within it) is protected by copyright and apart from the rights expressly granted within
this document to use the content, all rights are reserved. Any part of this document may be copied for use
internally in your organisation or business so that you can use Code-Point Open under the terms of your
licence (but not otherwise).

No part of this document may be reproduced or transmitted in any form or by any means (including
electronically) for commercial exploitation, onward sale or as free promotional material without getting the
written consent of Ordnance Survey beforehand.

This product contains National Statistics data © Crown copyright and database right 2023.

This product contains Royal Mail data © Royal Mail copyright and database right 2023.

Trade marks

Ordnance Survey, OS, the OS Logos and Code-Point are registered trade marks, and OS MasterMap
Topography Layer and Code-Point Open are trade marks of Ordnance Survey, Britain’s mapping agency.
Microsoft, Access and Excel are registered trademarks of Microsoft Corporation.

PAF, PO Box, Post Office and Royal Mail are registered trademarks of Royal Mail Group Ltd.

Contact details
OS website ‘Contact us’ page (https://www.ordnancesurvey.co.uk/contact-us).
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|.  Introduction to the product

Code-Point Open locates over |.7 million postcode units for Great Britain, each having a notional
geographical location. Postcodes are an alphanumeric abbreviated form of an address. Postcode units are
unique references and identify an average of |5 addresses. In some cases, where an address receives a
substantial amount of mail, a postcode will apply to only one address and is defined as a large-user
postcode. The maximum number of addresses in a postcode is 100.
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Figure I: Code-Point Open provides geographical locations for postcodes in Great Britain.
This getting started guide focusses on using the product in comma-separated values (CSV) format.

For guidance on using the product in GeoPackage format, please see the separate 'Getting started with
GeoPackage' guide which is available on the Code-Point Open Product Support page of the OS website
(https://www.ordnancesurvey.co.uk/business-government/tools-support/code-point-open-support).
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2.  Requirements for using the data

2.1 What you need to use Code-Point Open
Code-Point Open is a data product and does not include software for analysis but can be used with a

variety of programs. Code-Point Open can be loaded into a GIS (geographical information system) for
display and analysis of the data. Consult your GIS documentation to establish actual system requirements.

2.2 Supply mechanism

Code-Point Open is only available as national cover of Great Britain. The product is supplied in two
formats (CSV and GeoPackage) as an online download from the OS Data Hub (https://osdatahub.os.uk/).

2.3 Product update schedule

Updates are supplied quarterly (February, May, August and November) and provided as a complete
resupply. Any postcode that is deleted between supplies will not be included.

2.4 Coverage and file sizes

Code-Point Open covers postcodes for Great Britain. In CSV format, postcodes are divided into postcode
areas and supplied as 120 files. GeoPackage format is a self-contained database.

The approximate file sizes of the respective data formats are as follows:
+ CSV: I53MB

*  GeoPackage: 257MB
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2.5 Code-Point Open data structure

2.5.1 CSv

The Code-Point Open CSV format contains two folders in the root directory: Doc and Data
The Doc folder contains the following files:

*  Codelist.xlsx — Lookup table of Government Statistical Service (GSS) codes

* Code-Point_Open_Column_Headers.csv — Description of column headers

* licence.txt — Important licence information

* metadata.txt — Number of postcode units in each postcode area

* NHS_Codelist.xls — Lookup table of health GSS codes

* readme.txt — Summary of supplied data

The Data folder contains the following sub-folder:

* CSV — 120 postcode area files in CSV format

252 GeoPackage

The Code-Point Open GeoPackage format contains the following text file in the root directory:
* Readme.txt — Summary of supplied data

And two folders: Doc and Data

The Doc folder contains the following files:

* Codelist.xlsx — Lookup table of GSS codes

* Code-Point_Open_Column_Headers.csv — Description of column headers

* Licence.txt — Important licence information

* Metadata.txt — Number of postcode units in each postcode area

* NHS_Codelist.xls — Lookup table of health GSS codes

The Data folder contains the following file:

* Codepo_gb.gpkg — One postcode area file in GeoPackage format
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2.6 Available formats

2.6.1 CSv

The structure of Code-Point Open supplied in CSV is described in the product's Technical Specification,
which is available on the Code-Point Open Product Support page of the OS website
(https://www.ordnancesurvey.co.uk/business-government/tools-support/code-point-open-support).

2.6.2 GeoPackage

The structure of Code-Point Open supplied in GeoPackage is described in the product's Technical
Specification, which is available on the Code-Point Open Product Support page of the OS website
(https://www.ordnancesurvey.co.uk/business-government/tools-support/code-point-open-support).
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3.  CSV file processing

As Code-Point Open data is supplied in separate .csv files by two-digit grid references, the files will require
some processing in order to proceed.

The Great Britain .csv files should be combined with the Code-Point_Open_Column_Headers.csv. To do
this:

I. Before processing the data, create the following folder:
¢ Great Britain
Then, copy all the .csv files from the CSV folder for Great Britain into this folder (120 in total).

2. Add the Code-Point_Open_Column_Headers.csv (located in the Doc folder) into the Great Britain
folder and prefix the name with: aa_

Marme

aa_Code-Point_Open_Column_Headers.csv

ab.csv

x]

x]

B al.csv
B b.csy
x]

ba.csv

B bb.csv

CSV header file and Great Britain .csv files

3.1 Combining multiple CSV files

The following is an example of one way to combine all the individual .csv files into a single file by using a .bat
batch file.

Note: The .csv file that is created comes to approximately |50MB, and .7 million records. If this is opened in
Microsoft Excel, only the first million records can be seen as the software cannot display more than this number of
records.

To use the batch function:
I. Copy the following text and paste it into a new Notepad document: copy *.csv outputfile.csv

2. Save the Notepad document with the file extension .bat (for example, combine_csv.bat) in the
Great Britain folder containing the 120 Great Britain .csv files.

3. Close the .bat file and navigate to the Great Britain folder, where it was saved. Double-click on the .bat
file and an MS-DOS window will appear. Once the process is complete, the MS-DOS screen will close
automatically.

4. A new CSV file with the name outputfile.csv has now been created within the Great Britain folder. All
the .csv files apart from outputfile.csv can now be deleted as they have all been copied into the one
ouputfile.csv.
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The outputfile.csv will have two column headers at rows | and 2 — an abbreviated version and a full version.

A B G D E F G H J
1 |PC _IPQ EA NO cY RH LH cC DC WC
2 |Postcode Positional_quality_indicator Eastings Northings Country_code NHS_regional_HA_code NHS_HA_code Admin_county code Admin_district_code Admin_ward_code

5. Open the .csv file in a text editor (not Excel) and delete the column header that you don’t want to use,
ensuring that any resulting empty row is closed.

You will now have an output file ready for uploading into geospatial software (such as QGIS).
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4. Data measures

Ordnance Survey measures the data in its products in one or more of the ways set out in Table |:

Table I:

Data measure

Completeness

Logical
consistency

Positional
accuracy

Temporal
accuracy

Thematic
accuracy

(attribute
accuracy)

Definitions of data measures.

Definition

Presence and
absence of
features
against the
specified data
content!

Degree of
adherence to
logical rules
of data
structure,
attribution
and
relationships

Accuracy of
the position
of features

Accuracy of
temporal
attributes and
temporal
relationships
of features

Classification
of features
and their
attributes

Sub-measure

Omission

Commission

Conceptual
consistency

Domain
consistency

Format
consistency

Topological
consistency

Absolute
accuracy

Relative
accuracy

Geometric
fidelity

Temporal
consistency

Temporal
validity
(currency)

Classification
correctness

Definition

Features representing objects that conform to the
specified data content but are not present in the data.

Features representing objects that do not conform to
the specified data content but are present in the data.

How closely the data follows the conceptual rules (or
model).

How closely the data values in the dataset match the
range of values in the dataset specification.

The physical structure (syntax): how closely the data
stored and delivered fits the database schema and
agreed supply formats.

The explicit topological references between features
(connectivity) — according to specification.

How closely the coordinates of a point in the dataset
agree with the coordinates of the same point on the
ground (in the British National Grid reference
system).

Positional consistency of a data point or feature in
relation to other local data points or features within
the same or another reference dataset.

The ‘trueness’ of features to the shapes and
alignments of the objects they represent!.

How well-ordered events are recorded in the dataset
(lifecycles).

Validity of data with respect to time: the amount of
real-world change that has been incorporated in the
dataset that is scheduled for capture under current

specifications.

How accurately the attributes within the dataset
record the information about objects!'.

' When testing the data according to the dataset specification against the ‘real world’ or reference dataset.
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4.1 Metadata

Metadata, which is ISO 19115 UK GEMINI 2 compliant, can be found at
https://www.data.gov.uk/dataset/e3d9cd8e-e702-4fc6-a674-c|f25eb5efab/ordnance-survey-code-point-open.
Metadata .xml files can be found at http://www.ordnancesurvey.co.uk/oswebsite/xml/products/.
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5.  Loading the data into a GIS

The data can be loaded into several geographic information systems (GIS). This section describes how to
load the combined CSV output file (for more information on how to combine multiple CSV files, see
Section 3.1) into four commonly used GIS, including:

+ QGIS
* ArcGIS Pro
*  ArcMap

* Maplinfo Pro 2019

5.1 QGIS

The following step-by-step instructions outline how to load Code-Point Open CSV files into QGIS. They
have been prepared using version 3.8.1-Zanzibar of QGIS Desktop — an open-source GIS in which you can
create, edit and visualise and publish geographic information. You can download QGIS for free from the
'Download QGIS for your platform' page of the QGIS website
(http://www.qgis.org/en/site/forusers/download.html).

5.1.1 Loading and displaying the CSV supply
To load and display CSV data in QGIS:
I. Open an existing project in QGIS or create a new one.

2. In Layer, click Add Layer > Add Delimited Text Layer... or click on the Add Delimited Text Layer symbol in
the Manage Layers Toolbar.

IEVEY Settings Plugins Vector Raster Database Web Mesh Processing Help

\!Data Source Manager Ctrl+L b MO ¥ T =~ T -
Create Layer 4 _—_— Py a
A aye V; Add Vector Layer... Ctrl+Shift+V
Embed Layers and Groups... 'g Add Raster Layer... Ctrl+Shift+R
Add from Layer Definition File... EA Add Mesh Layer...
Copy Style « Add Delimited Text Layer... Ctrl+Shift+T
Paste Style 'g Add PostGIS Layers... Ctrl+Shift+D
Copy Layer /% Add Spatialite Layer... Ctrl+Shift+L
Paste Layer/Group g Add MSSQL Spatial Layer...
Open Attribute Table f6 [, Add DB2 Spatial Layer... Ctrl+Shift+2

@. Add Oracle Spatial Layer... Ctrl+Shift+O
W Add/Edit Virtual Layer...

Toggle Editing

Save Layer Edits

This will open the Data Source Manager Delimited Text dialog.
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3. In the Data Source Manager Delimited Text dialog:

a. File name: Use the ellipsis button (...) to the right of the File name pane to navigate to the saved
outputfile.csv.

b. File Format: Select CSV (comma separated values).

c. Record and Fields Options: Select First Record has field names.

d. Geometry Definition:
i) Select Point coordinates.
if) X field: Choose Eastings (or EA if the abbreviated column header was selected).
ii) Y field: Choose Northings (or NO if the abbreviated column header was selected).
iv) Geometry CRS: Select EPSG:27700 — OSGB 1936 / British National Grid.

e. Click Add.

@ Data Source Manager | Delimited Text x
g

i L File name |D:\cpTechSpec\cpOpen\Data\CSViputputfie, csv a
- Vector Layer name |outputfile Encoding | UTF-8 =

* Raster 'w File Format

.'.;!I; Mesh < ® C5V (comma separated values) >

, Delimited Text Regular expression delimiter

: Custom delimiters
5 # GeoPackage

w Record and Fields Options

ii Spatialite

Mumber gf bezdeclines to discard | 0 = Decimal separator is comma

- PostgreSOL
V| First record has field names Trim fields

* aL Discard empty fields

+ Oracle w Geometry Definition

well known text (WKT)

X field | Eastings

irtual Layer Y field | Northings

No geometry (attribute only table)

D
Geometry CRS < EPSG:27700 - OSGE 1936 / British Mational Grid - E >
P Layer Settings
Sample Data
ArcGlS Map Server Postcode Positional_quality_indicator Eastings Northings Country_code NHS_regional_HA_code NHS_HA _code A=
1 |AB101AB 10 394235 | 806529 | 592000003 502000020
HIEE D TR S 2 |ABID1AF 10 394235 806529 592000003 503000020
Out 3 |AB101AG 10 394230 | 806469 | 592000003 502000020 =
GeoMode
1 »
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It will take a minute or so to load the data into the map pane, but when it has finished, the map pane will look
like the example below:

OS Maps API Light 27700 is being used as the background map for geographic context

4. The outputfile can now be saved out into any format of your choosing.
It is best to do this, otherwise you will have to repeat the process of geoprocessing the outputfile.csv every time

you need to use it.
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5.2 ArcGIS Pro

The following step-by-step instructions outline how to load Code-Point Open CSV files into ArcGIS Pro.
They have been prepared using version 3.0.

5.2.1 Loading and displaying the CSV supply

To load and display CSV data in ArcGlIS Pro:

I. Open ArcGlIS Pro.

2. Open a project and name it (in this example, the project will be called cpOpen).

a. Browse to a memorable location in which to save the project and keep the ‘Create a new folder for
this project’ option checked.

b. Click OK.

Create a Mew Project X
MName cpOpen

Location | DAcpTechSpeccpOpentarcPro

Create a new folder for this project

Ok Cancel

3. Once the project opens, add a background map for geographic context (in this example, OS Maps API
Light 27700 has been added as the background map).

4. From the Map tab, click Add Data > XY Point Data.

hap Insert Analysis View Edit Imagery Share
| oeE M o B2 B0 N N [F

Con A KA i [ C1E
Paste ) Explore AR EN Bookmarks  Go Basemap | Add  Add Select Select By Select By
- Copy Path - - To X¥ - Data= Preset~ *  Attributes Location
Clipboard Mavigat P
ipboar avigate + Data _
Contents » 1 X m Add data to the map. | |
T | Search p | @3 Data From Path
B Add data using a local path or URL
=E8OM/ H& .
—_— wr XY Point Data

Drawing Order Add x,y point data te the map.

A Geoprocessing pane will open on the right-hand side of the map pane.
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5. In the Geoprocessing pane:

a. Input Table: Use the folder symbol to the right of the field to navigate to the outputfile.csv.

b. Output Feature Class: This will auto-populate.
c. X Field: Select Easting (or EA if the abbreviated column headers were chosen).

d. Y Field: Select Northing (or NO if the abbreviated column headers were chosen).

e. Coordinate System: Select Current Map [Map]. This will then populate with British National Grid
(the OS Maps API Light 27700 map has already been chosen for the background context mapping in

this example).

f.  Click Run at the bottom right of the Geoprocessing pane.

Geoprocessing

e XY Table To Point

Parameters Environments

Input Table
outputfile.csv

Output Feature Class

outputfile_X¥TableToPoint

X Field
Eastings
¥ Field
Morthings
Z Field

Coordinate System
British_Mational_Grid

p XY Table To Point
Initializing...

View Details Open History
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It will take a minute or so to load the data into the map pane, but when the data has finished loading, the map
pane will look like the example below:

OS Maps API Light 27700 has been used as the background map for geographic context.

As a result of this process, a new file geodatabase will have been created in the new folder that was created
when the project was opened.
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5.3

ArcMap

The following step-by-step instructions outline how to load Code-Point Open CSV files into ArcMap. They
have been prepared using version 10.7.1.

5.3.1

Loading and displaying the CSV supply

To load and display CSV data in ArcMap:

I. Open ArcMap.

2. Click on the Add Data button from the top ribbon.

File

Edit

View Bookmarks Insert Selection Geoprocessing  Customize  Windows  Help

B

& ® L EEEEE

3. In the Add Data dialog, browse to where you have saved your outputfile.csv, select the file and click

Add.

OFFICIAL

Add Data i
Lockin: B3] csv w %Q}L&|§'|ﬂ|ﬁl@$
|j|u.c5\.r |j np.Csy

|j m.csv |j nr.csy

|j Me.csv |j N, C5V

|j mk.csv |j ol.csv

e

|=] nuesv |=] ox.csw

|=] ne.csw |=] pa.csv

|j ng.csv |j pe.csv

=] nn.csv |j ph.csy

< >
Mame: outputfile.csy | I Add
Show of type: | patasets, Layers and Results - Cancel
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4. The file will now appear in the Table Of Contents.

File Edit View Bookmarks Insert Selection Ge
NEES B x| D b - |[1:15.0
CRCY R THME k@
Table Of Contents o=
U &84

5 = layers
= B3 DiepTechSpecicpCpentDatat C5V

= BT

5. Right-click on the outputfile.csv in the Table of Contents and select Display XY data...

Table Of Contents tx
: Zv *Elf g
5 £ Layers

= 3 DAcpTechSpecicpOpentData\ C5V

22 outputfile.q =

Light_27700

Open

Joins and Relates »
X Remove

Data [
Edit Features [

Geocode Addresses..,
Display Route Events...
Display XY Data... |

@ [%] # @

Properties...

| Display XY Data

Adds a new map layer based on
XY events from a table,

OFFICIAL
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6. In the Display XY Data dialog:

a. X Field: Select Eastings (or EA if the abbreviated column headers have been chosen).
b. Y Field: Select Northings (or NO if the abbreviated column headers have been chosen).

c. Coordinate System of the Input Coordinates: Select British National Grid.

d. Click OK.

Display XY Data d

A table containing X and ¥ coordinate data can be added to the
map as a layer

Choose a table from the map or browse for another table:

| outputfile.csv J
Spedify the fields for the X, ¥ and Z coordinates:

X Figld: |Easﬁngs L |
¥ Field: |Norﬂ1ings ~ |
Z Field: | <Mone ~ |

Coordinate System of Input Coordinates

Description:

Projected Coordinate System:
Mame: British_MNational_Grid

Geographic Coordinate System:
Mame: GCS_OSGE_1936

Edit...

Warn me if the resulting layer will have restricted functionality

About adding XY data Cancel

7. Click OK in the following window which will automatically pop up:

Table Does Mot Have Object-1D Field x

The table you specified does not have an Object-ID field so you will not

be able to select, query, or edit the features in the resulting layer, or
define relates for them.

After you create this layer, you can export it to a shapefile or feature
class if you need these functions. To export a layer, right-click it in the
Table Of Contents and choose Data> Export Data. Add the exported
data to the map as a new layer.

Cancel

The message warns you that the file resulting layer is only a temporary table and will need to be saved out.
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After a minute or so, the points will appear in the map pane; the map pane should look similar to the following
example:

3546409 116643357 Meters

OS Maps API Light 27700 has been used as the background map for geographic context.
8. Before the points can be used meaningfully, you'll need to save the layer out as a shapefile:
a. Right-click on the outputfile.csv Events layer in the Layers panel.

b. Click Export from the drop-down menu.

c. In the Export Data dialog, browse to and select a file name for the data.
d. Click OK.
Export Data >
Export: | All features R
|Use the same coordinate system as:
(®) this layer's source data
(") the data frame
the feature dataset you export the data into
(only applies if you export to a feature dataset in a geodatabase)
Qutput feature dass:
[ 'epTechSpectcpOpen' Data‘shp opOpen shp |
Bro
Cancel
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The shapefile will take several minutes to create, but progress can be monitored in the Export Progress window
that will automatically pop up. This window will close when the export is complete.

9. The following window will also pop up, giving you the option to add the newly created data to the

workspace.
If you click Yes, then a shapefile and associated files will be created at the chosen location.

ArcMap

| Do you want to add the exported data to the map as a layer?

Yes Mo
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54 Maplnfo Pro

The following step-by-step instructions outline how to load Code-Point Open CSV files into Maplnfo Pro.
They have been prepared using version Maplnfo Pro 2019, release build 58.

54.1 Loading and displaying the CSV supply
To load and display CSV data in Mapinfo Pro:
I. Open Maplinfo Pro 2019.

2. Select Open > Blank Workspace.

Open

Blank Workspace
Last Saved Session

Workspaces

cpOpen
Sample Workspaces...
Other Workspaces...

Tables

outputfile

Untitled

cpOpen_ 2022-10

cpOpen2022 10

osMaps

POI

Southwark parks and green spaces (0S5 Greenspa...
Greenspace

Other Tables...

Programs

multipend
Other Programs...

3. Open a mapping background for geographic context (in this example, OS Maps API Light 27700 has
been added as the background map).
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4. From the HOME tab, click Open Table.

Open  Open Save
- Table Workspace~

File

5. In the Open dialog:
a. Files of type: Change from Maplnfo.tab to Comma delimited CSV (*.csv).
b. Browse to outputfile.csv and click on it.

c. Click Open.

= Open x
Lookn: [ || CSV Y] @3 m-
Mame - Date modified Type Size 2
@H.cw 26/07/2022 12:10 Microsoft Excel C... 1641 KB
D?:'l‘:y Bllncsv 26/07/2022 12:09 Microsoft Excel C... 920 KB
. @\s‘csv 26/07/2022 12:09 Microsoft Excel C... 1,967 KB
% @\u.cs\r 26/07/202212:09 Microsoft Excel C... 567 KB
emote Tobles BLSLEZ 26/07/2022 12:09 Microsoft Excel C... 2,845K8
Directory @ me.csv 26/07/2022 1210 Microsoft Excel C... 1,584 KB
N @ mk.csv 26/07/2022 12:10 Microsoft Excel C... 1416 KB
% @ ml.csv 26/07/2022 12:10 Microsoft Excel C... T34KB
Import Files [T RN 26/07/202212:10 Microsoft Excel C... 1,546 KB
Din=5 B ne.csv 26/07/2022 12:10 Microsoft Excel C... 3,000 KB
% B3 ng.csv 26/07/2022 12:10 Microsoft Excel C... 2,815KB
[ — @ nn.csv 26/07/2022 12210 Microsoft Excel C... 1,489 KB
Directory @ np.csv 26/07/2022 1210 Microsoft Excel C... 1,123KB
@ nr.csw 26/07/2022 12:09 Microsoft Excel C... 2,339KB
@ nw.csv 26/07/2022 12:09 Microsoft Excel C... 1,255KB
@ ol.csv 26/07/2022 12:09 Microsoft Excel C... 1,180 KB
{837 outputfile,csv 13/10/2022 13:38 Microsoft Excel C... 157,397 KB :
@ 0X.C5% 26/07/2022 1210 Microsoft Excel C... 1,980 KB
@ pa.csv 26/07/2022 1210 Microsoft Excel C... T62 KB
@ pe.csv 26/07/2022 12:09 Microsoft Excel C... 2,615KB
@ ph.csv 26/07/2022 1210 Microsoft Excel C... 436 KB
B plcsv 26/07/2022 1210 Microsoft Excel C... 1,598 KB
@po.cw 26/07/2022 1210 Microsoft Excel C... 2,291KB
@ pr.csv 26/07/2022 1210 Microsoft Excel C... 1,289KB
B rg.csv 26/07/2022 1210 Microsoft Excel C... 2171 KB
@rh‘cw 26/07/2022 12:10 Microsoft Excel C... 1,593 KB
@ rm.csv 26/07/2022 12:09 Microsoft Excel C... B34 KB
@ 5.05v 26/07/2022 12:10 Microsoft Excel C... 3,034 KB
@sa‘cw 26/07/2022 12:10 Microsoft Excel C... 1,881 KB
@ se.csv 26/07/202212:10 Microsoft Excel C... 1,848 KB ©
= e e - - - R
File name [outputfie csv v [oen ]
Fiesoftype: | Comma delimted CSV ("csv) v | Cancal |
Preferred |Mmm - | ‘ Help |
View:
(®) MapInfo Places [C]create copy in MapInfo format for read fwrite
() Standard Places
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6. In the Comma Delimited CSV Information dialog:

a. Delimiter: Ensure that Other is checked and that a comma is visible next to it.

b. Check the Use First Line for Column Titles option.

c. Click OK.
Comma Delimited C5V Information >
Delimiter
() Tab (®) Other:

File Character Set:
Windows US & W, Europe ("TAMNSIT) w

[+]ise First Line for Column Titles!

Cance Help

It will take several minutes for the table to load, but when it does, a window called outputfile Browser will open:

P s s
w0 B siaozon s

wnin
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7. To create the points from the table, click on the SPATIAL tab from the top ribbon > Create > Create

Points.
VYR LAYOUT — RASTER  LEGACY
3
X < Q
. Buffer MNodes Modify Fix/Clean Transform Convert Calculate Insert  Style Regions Dimension Create Geocode
n Edit Create &J

4 Postcode Positional_quality_indicator Eastings Northings Country_code NHS_regional HA_code MNHS_HA_code Admin_county Points 1in_dist]

AB10 14B 10 394235 806529 S92000003 508000020 ﬁrﬂ 100033

4 AB10 14F 10 394235 808529 S92000003 508000020 Line fram 100033

AB10 1AG 10 394230 806469 S92000003 508000020 Table 100033

AB10 1AH 10 394235 808529 S92000003 508000020 ﬁfj 100033

AB10 1AL 10 394296 808581 592000003 508000020 100033

AB10 1AN 10 394367 806541 $92000003 508000020 ﬁzﬁ!:T'gLEIE 100033

AB10 1AP 10| 394309 806459 S$92000003 508000020 100033

AB1014Q 10 394371 8206359 $92000003 508000020 @ 100033

AB10 1AR 10| 394235 806529 $92000003 508000020 Circle 00033

AB10 1AS 10 394198 806385 $92000003 508000020 from Table jpn033

AB10 1AU 10| 394271 806323 S$92000003 508000020 % 100033

AB10 1AW 10 394226 206,282 S92000003 508000020 100033

AB10 14X 10 384235 806529 582000003 508000020 celfrom 350033

AB10 18A 10 394127 806442 592000003 508000020 Lo 100033

AB10 18B 10 394223 806,262 592000003 508000020 2 100033

AB10 18D 10 394272 808,289 S92000003 508000020 Flanked 100033

AB10 18F 10 394,187 806,225 592000003 508000020 Cells o033

8. In the Create Points dialog:

a. Projection: Change this from Longitude / Latitude (WGS 84) to British National Grid [EPSG:27700].
The easiest way to do this is to click the ellipsis button next to Projection and then tap B on the keyboard
6 times, highlight British National Grid [EPSG:27700] in the results and click OK.

b. using Symbol: The default style in this dialog is a square. You can change this to something a bit
more visible (for example, a red star) if you like by clicking on the ‘using Symbol’ button and
following the instructions.

c. Leave all the other settings.

d. Click OK.

Create Points *

Create Points for Table: | putputfile v

Projection: | British National Grid |

Add to Map: E Untitled Map
[ ] overwrite points using Symbol; T

Coordinates

Get X Coordinates from: Eastings R
iy
Get ¥ Coordinates from: Morthings e

[ pisplay non-numeric fislds

Conel | |t
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A progress bar will appear; it will disappear when the geoprocessing has finished:

Status X

Creating points for table outputfile. ..

280083 points created
0 already processed

] 25 50 75 100

Stop

Once the process has finished, the points will appear in the map pane with your chosen point style. The map
pane should look similar to the following example:

N
o T
) '.q._.;._\..a,‘.v;. .

g TREAIT Y
S “‘*".e;\_-“

3 7 . ‘n

ot S e
aidlr v s
SN T
Pl L
] R Seas
2%, N
LT

‘1‘
v,

L TR
w2
‘:-*ri":;‘ '3'-._?
eI o 3T
LR N
L
L e
,.

v

e

22t

o o ) G
B - s e L o A
ety '} ¥ i it
i e 8 3

A .tab file (and associated .MAP and .ID files) is automatically created in the same folder as the outputfile.csv.
However, these are the temporary files that are created as part of the point creation process and they will be
difficult to query.

OFFICIAL

© Ordnance Survey Ltd 2023 Page 27 of 31



CODE-POINT OPEN — GETTING STARTED GUIDE
May 2023

9. To save the outputfile layer as a true .tab file, click the HOME tab > Save > Save Copy As. In the
Save Copy As dialog, select outputfile and click Save As...

Save Copy As

Save Table:

Untitled

outputfile

Save As...

‘ E[
m
=
*

[0. In the Save Copy of Table As dialog, navigate to where you would like to save the .tab file, give it a

memorable name and click Save:

= Save Copy of Table As

Savein: | tab

v @ e @

A=0) Mame
==

Tables
Directory

A-5
—=

Remaote Tables
Directory

A=5
Import Files
Directory
&
Waorlkspaces
Directory

Date modified Type

N items match your search,

Size

File name |cpOpen_z022-10.T28]

Save as type: | Maplnfo (*tab)

[C]open new table using view: Automatic

(®) MapInfo Places
() Standard Places

A progress bar will once again appear and then disappear when the save has completed.

A more easily queryable .tab file will now be available to use in Maplnfo.
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Appendix A: Glossary

Glossary term

addressed premise

building

CPLC (Code-Point location coordinate)

Country code

Country Code

Comma-separated values (CSV)

delivery point

Gridlink

OFFICIAL
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Definition

A permanent or non-permanent building structure
with an address being a potential delivery point for
Royal Mail.

Examples of an addressed premise would be a house,
a flat within a block of flats, a caravan site, a bollard
to which several houseboats may be moored, or an
organisation occupying the whole building.

A physical, walled structure connected to
foundations that has, or will have, a roof. This
definition includes buildings surveyed at foundation
stage.

A National Grid reference for each postcode unit. It
is a two-dimensional coordinated point to a
resolution of | metre. Coordinates are attributed
from Gridlink using an accuracy hierarchy.

The code used by the Office of National Statistics to
indicate the country in which the Code-Point
georeference lies. This has replaced the PAF update
date field.

England E92000001
Scotland $92000003
Wales W92000004

N Ireland N92000002

The CSV file format is commonly used to exchange
data between different applications, for example,
Microsoft Excel and Access. Being text files, CSV
files can also be viewed in Notepad.

A Royal Mail-defined point to which mail is delivered.
This may be a property (private address),
organisation, mailbox or even, very rarely, the name
of an individual. These categories are derived from
the Programmers’ Guide from Royal Mail. This is
distinct from the addressed premise because there
may be more than one organisation at an address.

Gridlink is the name given to a joined-up
Government initiative involving Royal Mail, the
Office for National Statistics, National Records of
Scotland (NRS), Land & Property Services and
Ordnance Survey. All these organisations are
involved in the georeferencing of postcodes and the
relating of postcodes to administrative and National
Health Service areas and so on.
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Glossary term

inward code or incode

matched address

National Grid reference (NGref)

non-geographic postcodes

outward code or outcode

Postcode Address File (PAF)

Postal Address Location Feed (PALF)

positional quality indicator (PQI)

postal address

postcode
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Definition

See postcode.

An address, resulting from a match between the

OS MasterMap Topography Layer data and PAF,
which has been allocated a coordinate position. The
match may be a result of either manual or automatic
matching, the latter encompassing both full and
‘fuzzy logic’ matching.

The National Grid provides a unique reference
system that can be applied to all Ordnance Survey
maps of Great Britain. The map of Great Britain is
covered by 100 km by 100 km grid squares, with the
origin lying to the west of the Isles of Scilly. When a
National Grid reference is quoted, the easting (left
to right direction) is always given before the
northing (upwards direction).

A National Grid reference (to | metre) will identify
the spatial position of the CPLC.

Special non-geographic postcodes are allocated to
single organisations who receive an exceptionally
large amount of mail. These are included in Code-
Point Open.

See postcode.

PAF now contains the postal addresses and
postcodes of approximately 28 million delivery
points in Great Britain.

The PAL Feed is provided to Ordnance Survey from
GeoPlace, who have geocoded the PAF feed from
Royal Mail, using source coordinates from Local
Authorities in England, Wales & Scotland and
Ordnance Survey.

The positional quality indicator is a flag used to
indicate the positional accuracy of the coordinates
allocated to each postcode record. There are seven
PQI values for the positional quality of CPLCs.

A postal address is a delivery point that is currently
receiving mail. There may be many delivery points
within an individual building structure as shown in
OS MasterMap Topography Layer data.

An abbreviated form of address made up of
combinations of between six and eight alphanumeric
characters. A postcode may cover between | and
100 addresses. The average number of addresses per
postcode is |5.
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Glossary term

postcode area

postcode district

postcode sector

postcode unit
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Definition

An area given a unique alphabetic coding by Royal
Mail to facilitate the delivering of mail. The area is
identified by one or two alpha characters at the start
of the full postcode, the letters being derived from a
town, city or district falling within the postcode area.
There are, at present, 120 postcode areas in Great
Britain, for example, SO for Southampton, MK for
Milton Keynes, B for Birmingham or W for London
West. The postcode area code constitutes the first
part of the outward code.

A sub-area of the postcode area, specified by the
character sub-string within the first half of a full
postcode, which may be numeric, alphabetic or
alphanumeric; for example, 42 from MK42 6GH or
IA from WIA 4WW. There are approximately

2 986 postcode districts in Great Britain.

Note: There are certain non-geographic districts. In these
instances, a district code is allocated to cover all large
users in the postcode area.

A sub-area of a postcode district, whose area is
identified by the number third from the end of a full
postcode. There are approximately || 200 postcode
sectors in Great Britain. An example of a postcode
sector code is 3, from GUI2 3DH.

A sub-area of a postcode sector, indicated by the
two letters of the inward postcode, which identifies
one or more small-user postcode delivery points or
an individual large-user postcode. There are
approximately 1.7 million postcode units in the UK.
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